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Professionally designed sample reports

The program comes with professionally designed sample reports that demonstrate a wide range of reporting techniques. You can
create your own reports using these reports as templates.

For users of Seagate Crystal Reports Professional version
The sample reports are based on Crystal Dictionaries (except those samples with file names start with AD*.RPT).
1 Close Seagate Crystal Reports.

2 Open the required dictionary in CRD.EXE, add your own database and insert the appropriate tables and fields in the
dictionary view, making sure to use the same headings and field names as the original dictionary.

3 Save the altered dictionary.
4 Reopen Seagate Crystal Reports, and open the sample report.
The dictionary is now updated with your own data.

For users of Seagate Crystal Reports Standard version

All the standard sample reports are based on database files. We recommend that you call Seagate Software for an upgrade to
Seagate Crystal Reports Professional. You can change your data to use the templates provided, however the process is far
more involved:

1 Add your own database to the report.
2 Delete and replace all instances of the sample database fields in the report, including formulas with your own field names.
3 Delete the sample database.

Crystal Reports Sample Reports (Standard Edition) - Open SAMPLE_S.HLP located in the \CRW\ directory or the directory in
which you installed Crystal Reports.

Crystal Reports Sample Reports (Professional Edition) - Open SAMPLE_P.HLP located in the \CRW\ directory or the
directory in which you installed Crystal Reports.



Note to Developers: Obsolete API Calls

Because of new features in Seagate Crystal Reports, some of the older API calls are now obsolete. Users are able to place
fields freely on a report as the program no longer uses lines for field placement. Lines are now, for the most part sections. The
API calls which were used to deal with lines are also obsolete and have been removed from the header files. When existing
header files are replaced with the new header files, line calls must be changed to section calls in an application. For already
compiled applications, the old LineHeight calls point to the new Section calls for backward compatibility.

Obsolete calls

These calls are obsolete and are no longer included in the header files:
n PESetLineHeight
n PEGetNLinesInSection
n PEGetLineHeight

Old calls pointing to new calls

These old LineHeight calls now point to the new Section calls:
n PESetLineHeight now calls PESetMinimumSectionHeight
n PEGetLineHeight now calls PEGetMinimumSectionHeight
n PEGetNLinelnSection always returns 1



Using DBGrid with the Query Module

The Crystal Query Designer included with Seagate Crystal Reports makes use of the DBGrid control from Apex software. For
more information on the grid control, contact Apex Software at www.apexsc.com.
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Working with secured Access databases

In order for Seagate Crystal Reports to work with secured Access databases, you have to point the program to the Access
SYSTEM.MDA file or, if you're working with Access 95, to the SYSTEM.MDW file.

32-bit systems
When working with 32-bit systems, you need the following Registry setting:

Access
\\HKEY LOCAL MACHINE\Software\Seagate Software\Jet\3.0\Engines\Jet\SystemDB = < the path
of SYSTEM.MDA >

Access 95

\\HKEY LOCAL MACHINE\Software\Seagate Software\Jet\3.0\Engines\Jet\SystemDB = < the path
of SYSTEM.MDW >

16-bit systems
When working with 16-bit systems, you need the following entry in the CRW.INI file:
[Options]
SystemDB = < the path of SYSTEM.MDA >
Seagate Crystal Reports installs two utilities in the CRW directory that you can use to make these changes:
n For upgrading the Registry (32-bit systems), use SYSDB32.EXE.
n For upgrading the CRW.INI file (16-bit systems), use SYSDB16.EXE.
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IntelliMouse
n By simply moving the wheel rotation up or down, you can scroll up and down the page as if you were using the scroll bars.
n By pressing the Ctrl key and the wheel rotation on the IntelliMouse, you can zoom in and out on your reports.

n By pressing the Shift key and the wheel rotation on the IntelliMouse while the cursor is over an area that allows drill down,
the program will go to the drill down tab.

n For more information on IntelliMouse cursors, search for Cursors in Seagate Crystal Reports online Help.



Btrieve Microkernel Setup

During installation of Seagate Crystal Reports, Btrieve Microkernel components and related files are installed to a separate
directory \CRW\BTI (16-bit) or \CRW\BTI32 (32-bit). In order to setup the Btrieve Microkernel, run the setup (DBSETUP.EXE)
program from the appropriate directory. After the setup program has run once, you will be able to access DBSETUP.EXE from

the File/Program manager.



Online Help Distributed DLLs

The following files have been distributed with this online Help system in order to run the Internet access functions and set the
Internet browser or navigator to be used.

File Description

SETBROWS.EXE Executable that allows users to specify the browse path for an Internet browser or navigator.

INETWH16.DLL Registered by INETWIZX.EXE, adds the functionality for adding Internet access to 16-bit
Help systems.

INETWH32.DLL Registered by INETWIZX.EXE, adds the functionality for adding Internet access to 32-bit

Help systems.

How Crystal Smart viewers perform on different platforms

Platform Operating Browser Java Comments
System VM

Intel NT4 IE 3.x/4.x The following are functional:
Windows 95 n HTML
n Frames
n Java
n ActiveX
IE 3.0 The following are functional:
(4.70.1155) » HTML
n Frames
n  ActiveX
The following are not functional:
n Java (need IE build later than 4.70.1155)
IE 3.0 The following are functional:
n HTML
n Frames
n Java
The following are not functional:
n ActiveX
Netscape 4.x The following are functional:
n HTML
n Frames
n Java
The following are not available:
n ActiveX
Netscape 3.0 The following are functional:
n HTML
n Frames
n Java
The following are not available:
n ActiveX
Note the following:

n Drilldown in Frames followed by clicking the
Back button does not load the previous
page. This is an issue with JavaScript in
Netscape.

Netscape The following are functional:
3.01 n HTML
n Frames
n Java
The following are not functional:
n ActiveX
Note the following:

n Drilldown in Frames followed by clicking the
Back button does not load the previous



PowerPC

Netscape
Gold 3.x
Win 3.11 Netscape 3.0
Netscape
Gold 3.0
IE 3.02a
IE 4 PP1
0S/2 Netscape
2.02
MacOS 7.6 IE 3.01 Apple
VM
MS VM
IE4 PP1 Apple
VM

page. This is an issue with JavaScript in
Netscape. Use the View Tabs on the right
side of the toolbar.

The following are functional:
n HTML
n Frames
The following are not functional:

n Java (Will not load properly. Use the View
Tabs on the right side of the toolbar.)

The following are not available:
n ActiveX
Note the following:

n Drilldown in Frames followed by clicking the
Back button does not load the previous
page. This is an issue with JavaScript in
Netscape.

The following are functional:
n HTML
n Frames
n Java (but scrollbars are missing)
The following are not available:
n ActiveX
The following are functional:
n HTML
n Frames
n Java (but scrollbars are missing)
n ActiveX
Note the following:

n General Protection Fault are viewing a
report using issue in Internet Explorer -
cookies are not being handled properly.

The following are functional:
n HTML

n Frames

n Java

n ActiveX

The following are functional:
n HTML

n Frames

n Java (Font sizes are smaller and images
are larger than normal)

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames



MS VM

MS JIT
VM

Netscape
4.01

MacOS 8 IE 3.01 Apple
VM

MS VM

MS JIT

IE4 PP1 Apple

VM

MS VM

MS JIT
VM

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:
n  ActiveX

The following are functional:

n HTML

n Frames

n Java

The following are not available:



Netscape
4.01
Unix Solaris Netscape 4.0
HP Netscape
3.01

n ActiveX
The following are functional:
n HTML
n Frames
n Java
The following are not available:
n ActiveX
The following are functional:
n HTML
n Frames
n Java
The following are not available:
n ActiveX
The following are functional:
n HTML
n Frames
n Java
The following are not available:
n ActiveX

E2 ReportServer settings and corresponding Reqistry keys
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ReportServer settings and corresponding Registry keys
[HKEY_LOCAL_MACHINE\SOFTWARE\Seagate Software\Crystal Reports\WebOptions]

Keys

"CacheSize"
"MaxActiveJobs"
"ThreadPoolSize"
"ActiveJobTimeout"
"RefreshReport"
"GroupView"
"GroupViewMaxSize
"CacheDir"

"RequestTimeout"
"ServerStartupTime"
"Cleanuplnterval”
"Viewer"

"ViewerPath"

Default Values
"10240"

noQn

nq

60"

wq

wq

"10000"

"C:\Program
Files\Seagate
Crystal

Reports\crweb\
cachedir"

n3Qn
Q"
"G
"lviewer"

"C:\Program
Files\Seagate
Crystal Reports\
crweb\"

Comments

Maximum cache size in the directory specified by CacheDir.
Maximum number of jobs kept opened.

Number of threads necessary to process reports.

The time-out interval set for when inactive jobs will be closed.
Enable refresh report capability.

Enable the Group Tree view.

The maximum number of group instance to be processed.
The directory where the temporary files will be stored.

The time-out interval set for a request.
The time-out interval set for when the ReportServer will start.
The time interval set for when clean up will be done.

The virtual path setup in the web server that points to the directory
containing the viewers.

The physical path that points to the directory containing the viewers.

B How Crystal Smart viewers perform on different platforms
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Other known Crystal Web Server issues

n

If a particular report has been kept active (opened), that report can not be modified as it is opened in exclusive mode. Either
wait for the active job to time-out or shut down the server to free up the reports.

Current implementation only has one thread to process reports.

If running the ReportsServer on a slower machine, it is recommended to increase the ServerStartupTime and
RequestTimeout.

The Cleanuplinterval should not be too small because during cleanup, no other requests will be served. Cleaning also will have
the overhead of deleting temp files.

The Web Configuration Utility (WEBCONF.EXE) includes four tabs; any tab that is not visited will not update the registry entry.

HTML search begins searching on the next page (the page following the one you begin the search on) and it is a forward
search.

Running more that one web server at a time might cause problems. It is recommended to run only one web server at a time.
If a user logs on to a database for one report and then moves to a second report by logging on with a different user id and
password, if the user tries to view the third report that has the exact logon as the first report, he will again be prompted. This
is because ReportServer only remembers the last set of user id and password entered.

Firewalls might prevent the ActiveX and Java viewers from being downloaded to the local browser.

Searching from HTML interface (includes HTML frame and page) is only a forward search beginning on the next page.
Internet Explorer on the Macintosh does not support viewer percentage properly so the Java viewer has a fixed size of 400 x
600.

There seems to be an issue with |IE 3.02 Java VB such that the Java Viewer will not work properly with an ASP backend.
You should always go through the Web Configuration Utility (WEBCONF.EXE) to change setting of the ReportServer.

The Crystal Report Page-On-Demand Server (CRPGSVR.EXE) must be started manually on the IIS server running under an
account with proper network rights so that virtual directories can be used that point to network drives. Otherwise, an access
denied error will be returned when attempting to view a report on the virtual directory. The automatic startup of the Web
Configuration Utility (WEBCONF.EXE) will be run under the System Account. Because this may cause problems accessing
secured items such as reports on other machines on the network and connecting to an Informix database. To work around
this issue, execute the CRPGSVR.EXE manually and then start the Web Server.

A bug with Microsoft's Internet Explorer 3.02 prevents Java applets from loading properly when the system is set to True
Color (Windows platforms only).

Printing from the Java viewer is not yet available for Macintosh versions of Netscape 4.x and Microsoft Internet Explorer 4.0.
Printing from the Java viewer is not yet available for Unix versions of Netscape 4.x.

B How Crystal Smart viewers perform on different platforms
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Development issues using active server pages

Microsoft's Internet Information Server (1IS) has a session timeout for each user. If you are planning on using Active Server
Pages to create reports and then test your success by looking at the reports in a viewer, you may have problems getting back
into the report after you shut down your web browser. The reason is that IS has a default timeout for a user's session set at
about 20 minutes. Even though you have closed your browser, your session is still running on [IS.  This means that the report
is still open on the web server. You will not be able to save your modifications in Seagate Crystal Reports in a report that is
being held open by another application.

In order to get around this problem, when you open the report in your Active Server script by calling the OpenReport method of
the Application Object, please use the new parameter OpenMethod of the OpenReport method.

The values available for the parameter are crOpenReportbyDefault and crOpenReportbyTempCopy. CrOpenReportbyDefault
opens the report in the standard way (read-only and can not be deleted), whereas crOpenReportbyTempCopy first copies the
report to a temporary file, leaving the original alone.

This will allow you to open the report (RPT) file in your development environment or Seagate Crystal Reports after shutting down
your web browser (instead of waiting for the usual 20 minutes).



Changes to the Crystal Report Automation Server (CPEAUT)

The Crystal Report Automation Server has had some last-minute changes. The changes were made to make the Crystal Report
Automation Server synchronized with the Crystal Report Engine. The changes are as follows:

n

The read-only property, GroupName, has been added to the PageGenerator. This is required by the Crystal Report
Automation Server to communicate properly with the Crystal Report Engine. It allows drilldown on graphs to bring up the
drilldown tab (with its title) while processing of the drilldown is still occurring.

MatchLogOnlInfo has been added as a write-only property to the GlobalOptions. It has been added to control security of
multiple users.

DLLName has been deleted from the DatabaseTable.SetLogOnInfo method.

There is an optional parameter added to Application.OpenReprort, call OpenMethod of typed CROpenReportMethod. This
corresponds to PEOpenPrintJobWithInfo.

crNavy has been added to CRColor for the 32-bit Application.



Exporting to HTML

Providing support for the Internet and corporate intranets becomes more important with every passing day. Seagate Crystal
Reports recognizes this importance and provides World Wide Web support. Although incorporated as an export format, HTML
represents a whole new export destination for your reports as well.

By exporting your reports in HTML format, Seagate Crystal Reports provides you with a new option for rapid, convenient
distribution of important company data. Once exported, your reports are accessible with many of the most popular web browsers
including Netscape and Microsoft Internet Explorer.

1
2

With the report you want to export active, click the Export button on the standard toolbar. The Export dialog box appears.
From the Format drop-down box, select one of the HTML formats listed.
n If Netscape 2.x (or earlier) or Internet Explorer 1.x is your browser, select HTML 3.2 (Standard) format.

n If you are using Internet Explorer 2.0 (or later) or Netscape 3.0 (or later) choose HTML 3.2 (Extended) format. This format
will create output containing bgcolor HTML tags approximating section background color and object adornments in the
report. Choose this option if you are uncertain.

n The World Wide Web Standards Organization has replaced its HTML 3.0 (Draft) specification with its HTML 3.2
(Standard). However, if you require this form of output, choose the HTML 3.0 (Draft) format.

Select a destination from the Destination drop-down box such as a disk file, an e-mail address, Microsoft Exchange, or Lotus

Notes. The rest of this section assumes you select Disk file to store the HTML document in a directory on a web server.

Click OK. The Export To Directory dialog box appears. When exported to HTML format, a report may make more than one

HTML file. For this reason, the program asks you for the name of a directory to export the report to, and uses default names

for the HTML files. The initial HTML page will be saved as DEFAULT.HTM. This is the file you open if you want to view your

report through your web browser.

Select an existing directory, or create a new directory for the report.

Click OK. The program exports the report to HTML format.



Release Notes

DEVELOPR.HLP (32-bit)
The following information is incorrect.

"Subreports cannot be modified at runtime through the ActiveX control but they can be modified using direct calls to the
Report Engine API. If you want to modify subreports at runtime, you will not be able to use the ActiveX control with your
application; you will have to create a Custom Print Link using the Report Engine API."

Correction: Subreports CAN BE modified at runtime through the ActiveX control for Crystal Reports version 6.0.
Where is this information documented?

1 Click on the developer.hlp file or Seagate Crystal Reports Developer's Help option from the program group.
2 From the Contents tab, click on Crystal ActiveX Control option.

3 Click on the ActiveX Control Properties Index option.

4 Clickonthe << button on the toolbar.

DEVELOPR.HLP (32-bit)

The developer.hlp implies properties available for the VBX in 32bit, which is incorrect. There aren't any properties for the VBX for
32bit platforms.

Where is this information documented?

The First location of this information is:

1 Click on the developer.hlp file or Seagate Crystal Reports Developer's Help option from the program group.
2 From the Contents tab, click on the Crystal Custom Control option.

The Section Code(32-bit) option should not exist, as the VBX is not available in 32bit.

The second location of this information is:

1 Click on the developer.hlp file or Seagate Crystal Reports Developer's Help option from the program group.
2 From the Contents tab, click on the Crystal Custom Control option.

3 Click on the Overview options.

The Section Code(32-bit) option should not exist, as the VBX is not available in 32bit.

FYI:

n Error messages prompting for missing files in 32bit Crystal Reports prompt for the 16bit filename instead of the 32bit
filenames.

n If you are distributing reports which use MSVCRT40.DLL (for example, 32-bit distribution for Access 7/8 using DAO 3.5) you
will need to be manually included in the Distribution Expert for the client machine if the client machine does not have VB5 or
Access 7/8 on their machines. The version of the MSVCRT40.DLL determines whether the MSVCRIT.DLL is required or not
(for example, version 4.20.6172 requires that DLL).

DEVELOPR.HLP (32-bit)

The following information in the developer.hlip file is INCORRECT.

"If your Rowset contains only a single field, you can use a one dimensional array instead of two dimensional. The single
dimension indicates the number of rows or records in your Rowset."

Correction: If you wish to add to your Rowset one record at a time, you can use a one dimensional array instead of a two
dimensional array. The single

dimension would represent the number of fields to be added to the Rowset.

FYI:

n Using the Crystal Data Object, the row is added twice. This occurs only on a single dimensional array.

n Please watch the Seagate Software web page: www.seagatesoftware.com, for any updates to this issue.

n When using the WindowState property in the VCL with Delphi 3, the "wsminimized" and "wsnormal" both produce a normal
window.

n When you use "PeOutputToWindow" With Delphi 3, the "WS_Minimized" and "WS_Normal" (See note below) are both
"Normal".

;’& There is no "WS_NORMAL" in the

. help and it won't accept it in the
call, you simply use "0" instead
which is the same as "Normal."”

n In Crystal Reports 32bit, there are no PG Editor templates installed in the GALLERY directory.

For more information on the latest release notes, please visit the Tech Support area on our website at http://www.
seagatesoftware.com/crystalreports/techsupp/
Please contact Tech Support at 604-669-8379 for further information.



Microsoft Office Compatibility

This product is Microsoft Office Compatible. For more information on Microsoft's Office Compatibility specifications, please visit
Microsoft's homepage at www.microsoft.com.



Installation Topics Index
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Installation Requirements (16-bit version)
The 16-bit version of Seagate Crystal Reports has the following installation requirements:
n Microsoft Windows 3.1 or higher
n Minimum RAM: 8 MB (16 MB for Windows NT 3.51 or higher)
n Recommended RAM: 16 MB (32 MB for Windows NT 3.51 or higher)
n  Minimum hard drive space required: 18 MB
n Maximum hard drive space required:
— 75 MB for the Standard Edition
— 108 MB for the Professional Edition

[ |nstallation Requirements (32-bit version)
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Installation Requirements - 32-bit version
The 32-bit version of Seagate Crystal Reports has the following installation requirements:
n Microsoft Windows 95 or Microsoft Windows NT 3.51 or higher
n Minimum RAM: 8 MB (16 MB for Windows NT)
n Recommended RAM: 20 MB (32 MB for Windows NT)
n  Minimum hard drive space required: 21 MB
n Maximum hard drive space required:
— 90 MB for the Standard Edition
— 148 MB for the Professional Edition
If your system does not meet these requirements, the program may not run correctly.

[ |nstallation Requirements (16-bit version)
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Installing Seagate Crystal Reports

Insert the CD or diskette in the appropriate disk drive.

Windows 3.1 or NT 3.51
1 Choose the Run command from the File menu.
2 When the Run dialog box appears, type:
x:\setup
«x represents the appropriate drive letter.»
For example, if your CD is in drive d:, type:
d:\setup
3 Click OK or press Enter to activate the installation program. The Installation dialog box appears.
4 Follow the directions on the screen to set up the program.
During the installation procedure, you can choose an Automatic or Custom installation.
n If you select Automatic, all of the program files are installed to your hard drive.
n If you select Custom, you will be given the opportunity to select which program files are installed to your hard drive.

Windows 95 or NT 4.0
1 Choose Run from the Start menu.
2 When the Run dialog box appears, type:
x:\setup
«x represents the appropriate drive letter.»
For example, if your CD is in drive d:, type:
d:\setup
3 Click OK or press Enter to activate the installation program. The Installation dialog box appears.
4 Follow the directions on the screen to set up the program.
During the installation procedure, you can choose an Automatic or Custom installation.
n If you select Automatic, all of the program files are installed to your hard drive.
n If you select Custom, you will be given the opportunity to select which program files are installed to your hard drive.

[l |nstallation Requirements (16-bit version
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Installing on a network workstation

If you are operating a network workstation that runs Windows locally and Seagate Crystal Reports is already installed on your
network server, you do not need to install the program on your workstation. Instead, you can run the workstation setup
application that was installed with Seagate Crystal Reports.

During installation, you can choose a Full Network Install or a Partial Network Install.

n A Full Network Install installs all application modules on the network server and allows users to run the program from the
shared drive. This method is recommended for diskless workstations.

n A Partial Network Install installs only the main application modules on the network server. This type of installation requires
each user to run a workstation setup to install several modules on the client machine. With this installation method, the
program will run faster and will take up less local disk space than a Local Install.

Workstation setup (SETUP.EXE) is installed in the \CRW\WKCSETUP (16-bit) or \CRW\WKCSTP32 (32-bit) directory on the
network drive on which Seagate Crystal Reports was installed.

Windows 3.1 or NT
1 From the Program Manager, choose Run from the File menu. The Run dialog box appears.

2 In the Run dialog box, highlight the network drive and directory in which Workstation Setup resides and run the SETUP.EXE
application.

3 Follow the directions on the screen to set up your workstation.

Windows 95 or NT 4.0
1 Choose Run from the Start menu. The Run dialog box appears.

2 In the Run dialog box, highlight the network drive and directory in which Workstation Setup resides and run the SETUP.EXE
application.

3 Follow the directions on the screen to set up your workstation.

[ |nstallation Requirements (16-bit version)
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Upgrading from a previous version

If you are upgrading from a previous version (4.5, 5.0, Crystal Reports for Visual Basic, etc.), the installation routine ensures that
there will be no conflict between different versions of the program running on the same machine. When it finds a previous
version of Seagate Crystal Reports on your system, the setup application:

n

n

n

n

n

installs the program to the directory you specify,

installs the new CRPExx.DLL into the \WINDOWS\SYSTEM directory,

renames DLLs in the WINDOWS\CRYSTAL directory, installed by your previous version of Seagate Crystal Reports, with
*.0OLD extensions (if, for some reason, you need to use the older versions of the files later on, you only need to rename them
back to a *.DLL extension),

installs the PD*.DLLs and UX*.DLLs (16-bit) or the P2*.DLLs and U2*.DLLs (32-bit), and several other DLL files required by
the program into the WINDOWS\CRYSTAL and WINDOWS\SYSTEM directory, and

installs any common third party DLLs such as CTL3DV2.DLL or WBTRCALL.DLL to the WINDOWS\SYSTEM directory.
removes CCSDK.DLL and installs it into WINDOWS\SYSTEM.

This upgrade procedure makes it unnecessary to change your AUTOEXEC.BAT file.

3] |nstallation Requirements (16-bit version

[ |nstallation Requirements (32-bit version)
= Installing Seagate Crystal Reports



Configuration and Setup Topics Index

dhj Click the topic of interest from the following list for further information:
Btrieve page size too small
Default printer must be selected

= ReadMe Index



Btrieve page size too small

During installation, Seagate Crystal Reports adds the following entry in BTI.INI:
[Btrieve Client]
options=/m:38 /p:1024 /f:16 /1:20

The p is the parameter for page size, and, in certain situations, it may not be large enough. You can change this setting to a
maximum of 4096.

To correct the problem

When using Btrieve files, if you get a message that the page size is not large enough, increase this parameter in the BTLINI file
using the Windows Notepad or another ASCII text editor.

For additional information on modifying BTLINI files, please refer to the documentation that came with Btrieve.

2| Configuration, and Setup Topics Index



Default printer must be selected

You can not begin using Seagate Crystal Reports unless you have a default printer selected because page layout
(Landscape/Portrait orientation, etc.) is based on the printer setup. Trying to start the program without a default printer results in
the following error message:

No default printer selected. You may use the Control Panel to select a default printer.

To select a default printer
Click the Printers icon in the Windows Control Panel. The Printers dialog box appears with all installed printers listed in the
Installed Printers box.
n If you have already installed the printer you want to use as the default printer, double-click its listing in the Installed Printers
box.

n If you have not yet installed the printer, install it first, and then double-click its listing.

-’3 A printer must first be given the
{ status Active before it can be
selected as the default printer.

{3 For additional information on
installing printers and default
printers, please refer to your
Microsoft Windows
documentation.
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Finland
France
Germany
Greece
Hong Kong

Hungary
India

Ireland
Israel
Ital

apa

XEL

ore

Luxembourg
Mexico

)

New Zealand
Netherlands
Norway
Philippines
Poland
Portugal
Russia
Singapore
South Africa
Spain
Sweden
Taiwan ROC
Thailand
Turkey
United Arab Emirates

United Kingdom
Venezuela




Argentina

SOFTLAND

Mansilla 2437 1 er piso

(1121) Buenos Aires

Argentina

Ph: 54-1-964-2100

Fax: 54-1-964-2270

E-mail: Info@softland.com.ar

Web: www.softland.com.ar

Intranet:  964-2300

AutoFAX: 964-2400 (Fax On Demand System)



Australia

AERONAUT INDUSTRIES
Ground Floor

48 Chandos Street

St Leonards NSW2065

Ph: 61-2-9436-1175

Fax: 61-2-9436-1184

E-mail: sales@aeronaut.com.au



Austria
Contact Seagate Software Germany.

MICRO BASIC

Am Sommerfeld 11
D-85622 Weissenfeld
Ph: 49-89-9049-9049
Fax: 49-89-9049-9090



Belgium
Contact Seagate Software France.




Brazil

ETZ Informatica Ltda.

Rua Haddock Lobo 337/41B
01414-001 Sao Paulo, SP
Brazil

Ph: 55-11-214-2678

Fax: 55-11-3159-0064
E-mail: etz@dialdata.com.br

Soft Consultoria

Rua Jorge Rudge 61

Vila Isabel

CEP 20550-220

Rio de Janeiro, RJ

Brazil

Ph: 5521 568-8892

Fax: 55 21 264-9989

E-mail: gsantoro@soft.com.br



Chile

BUSINESS INTELLIGENCE GROUP (B.l.G.)
Avenida 11 de Septiembre 2214 Piso 11
Oficina 112, Providencia

Santiago, Chile

Ph: 56-2-233-8516

Fax: 56 2-366-0169

E-mail: business@chilesat.net



Columbia

ESTRATEGIAS Y SISTEMAS CIA LTDA.
Carrera 37 No. 89-99

A.A. 251312 Santafe de Bogota
Colombia

Ph: 57-1-236-1696

Fax: 57-1-617-7530

E-mail: eysjosem@openway.com.co



Cyprus

CYCOM COMPUTER PRODUCTS LTD.
City House, 19th Dervis St.

P.O. Box 5732

Nicosia, Cyprus

Ph: 357-2-454448

Fax: 357-2-454707



Czech Republic

SWS SOFTWARE s.r.o.
Dostihova 1

763 15 Slusovice

Ph: 42-67-7981036
Fax: 42-67-7981008

ABAKUS DISTRIBUTION A.S.
Krizikova 35

180 00 Praha 8 Karlin

Ph: 420-2-218-63111

Fax: 420-2-218-63999



Denmark

NORSOFT A/S
Maren Turis Gade 2
DK-9100, Aalborg
Ph: 45-98-11-1188
Fax: 45-98-11-1088



Finland

BOSS INFORMATION
Sepankatu 14 A
SF-40720, Jyvaskyla
Ph: 358-14-334-3411
Fax: 358-14-334-3444



France

SEAGATE SOFTWARE S.A.
62bis Avenue André Morizet

92643 Boulogne-Billancourt Cedex
Ph: 33-1-41-10 16 00

Fax: 33-1-46-04 74 19

Distributor:

SOFTWARE TECHNOLOGY RESOURCES
7 rue Paul Dautier

78140, Velizy

Ph: 33-1-3070-6161

Fax: 33-1-3946-3864



Germany

SEAGATE SOFTWARE GMBH
Jacob-Kaiser-Str. 7

D-47877 Willich

Germany

Ph: 011-49-2154-489 120
Fax: 011-49-2154-498 500

Distributors:

MICRO BASIC

Am Sommerfeld 11
D-85622 Weissenfeld
Ph: 49-89-9049-9049
Fax: 49-89-9049-9090

E-mail: SERVICE@MicroBasic.com

MICROWARE GMBH
Moselstrasse 21

41464 Neuss

Ph: 49-2131 94 45-0
Fax: 49-21314 37 04



Greece
Contact Seagate Software France.




Hong Kong

DATADEVELOP LTD

Rm 1001-3 Fourseas Bldg.
208-212 Nathan Road
Kowloon, HongKong

Ph: 852-2-312-6038

Fax: 852-2-314-3672
E-mail: dglpsd@nkstar.com



Hungary
QUESTAR HUNGARY
Huvosvolgyi ut 54
H-1021 Budapest

Ph: 36-1-202-6373
Fax: 36-1-202-6375



India

LARSEN & TOUBRO LTD.

Arunjit Chowdhury

Powal, Bombay

India 400 072

Ph: 91-22-852-3309

Fax: 91-22-852-1592

E-mail: akc-isd@smtpg.ltindia.com



Ireland
Contact Seagate Software UK.




Israel

BYNET

Hanechoset, 8

Ramat Hahayal

Tel Aviv - 69710

Ph: 972 36459515
Fax: 972 3 648 2152



Italy

Contact Seagate Software France.

QUESTAR

Via Ghislandi, 61/B
24125 Bergamo

Ph: 39-35-24-9946
Fax: 39-35-24-9945
E-mail: info@questar.it
Web: www.questar.it



Japan

AG TECH

Bell Ace Building 4F

1-10-9 Higashi Sakura

Higashi-Ku, Nagoya 461

Ph: 81-52-951-2706

Fax: 81-52-951-4469

E-mail:  72041.1166@compuserve.com

WOODLAND CORP.

2-9-9 Shibadaimon Minato-ku
Tokyo 105

Japan

Ph: 81-6-204-0611

Fax: 81-6-229-0506

E-mail: shimada@woodland.co.jp



Korea

INFOTECH

5 Floor Wha Building

238, Nonhyon-Dong, Kangnam-ku
Seoul 135-010

Ph: 82-23-442-0400

Fax: 82-23-442-1960

CC COM

Rodem Bldg 3F

834-77 Yeosam-dong, Kangnam-gu
Seoul 135-080

Ph: 82-2-538-8700

Fax: 82-2-538-8716

E-mail: 100053.377@compuserve.com



Luxembourg
Contact Seagate Software France.




Mexico

OPENTEC SA de CV

Insurgentes Sur 2047-4

Col.San Angel

01000 Mexico D.F.

Mexico

Ph: 52-5-661-4472

Fax: 52-5-661-3571

E-mail: CMEJIA@opentec.com.mx



New Zealand

UNILOGIC Limited

Bldg 4, 666 Great South Road
P.O. Box 62-620 Central Park
Ph: 649 5250077

Fax: 64 9 525 1007

E-mail: crystal@unilogic.co.nz



Netherlands

COMPUTER BUSINESS APPLICATIONS BV
Postbus 8866

1006 JB Amsterdam

Keurenplein 24-46

1069 CD Amsterdam

Ph: 31206104888

Fax: 3120610 6686



Norway

COMPUTER RESOURCES INTERNATIONAL
Postboks 139 Kjelsas

0411 Oslo

Ph: 47-22-236893

Fax: 47-22-952355

POLYSOFT A/S
Rosenkrantsgt. 95
Box 829

N-3007 Drammen
Ph: 47-3289-2240
Fax: 47-3289-5900



Philippines

PACIFIC COMPUTER & MANAGEMENT SYSTEMS
5E Vernida 1 Bldg, 120

Amorsolo St. Legaspi Village

Makati City, MM

Ph: 632-892-2148

Fax: 632-818-3807

E-mail: titodel@helios.iconn.com.ph



Poland

POLCOM SP Z.0.0.
ul. G. Zapolskiej 38
30-126 Krakow

Poland

Ph: 0048-12-36 71 77
Fax: 0048-12-37 60 62



Portugal

PRIMAVERA SOFTWARE

R. Cidada do Porto no.15

Sala E-11

4700 Braga

Ph: 351-53 6051040

Fax: 351-53 6051049

E-mail: primavera@mail.telepac.pt
Web: www.primaverasoft.pt



Russia
Contact Seagate Software Germany.

INTERFACE LTD.

Alexander Brjuzgin

Room 308, Building 6

Bardeen St. 4

Moscow

Ph:  7-095-135-5500

Fax: 7-095-135-2519

E-mail: mail@interface.msk.su



Singapore

NOVA SPRINT CONSULTING

Block 1002 Jalan Bukit

Merah, #03-16/20 Redhill Industrial Estate
159456

Ph: 65-275-9088

Fax: 65-275-9388

E-mail: laitk@novasprint.com.sg



South Africa

SEAGATE SOFTWARE SOUTH AFRICA
376 Oak Avenue

Randburg 2125

Ph: 27-11-781-2200

Fax: 27-11-781-2214



Spain

Contact Seagate Software France.

RAMBLA INFORMATICA
Primer de Maig 2-22 baixos
08320, El Masnou, Barcelona
Ph: 34-3-540-2982

Fax: 34-3-540-3095

DANYSOFT INTERNATIONAL
Pase De Albacete, 73

28700 S.S. De Los Reyes
Madrid, Spain

Ph: 34-1-6546298

Fax: 34-1-6546382



Sweden

LINSOFT

S:t Largatan 9 D
Linkoping

Ph: 46-13-31-1588
Fax: 46-13-13-5695



Taiwan ROC

WARDPRO INFORMATION CORP.
4F-1, No 20 Alley 1 Lane 768
Section 4 Pa-Teh Road, Taipei
Taiwan

Ph: 886-2-788-6777

Fax: 886-2-785-3220



Thailand

INDEC TECHNOLOGY COMPANY
436 Soi 12

Paholyotin Road

Bangkok 10400

Ph: 662-616-7180

Fax: 662-279-1556

SAHASEDSIRIRI LTD. PARTNERSHIP
2104/48 Soi Mooban Decha Ramkamaeng Rd.
Huamark Bangkapi

Bangkok 10240

Ph: 662-732-3268

Fax: 662-374-7163

E-mail: narun@ksc6.th.com



Turkey

OPTIMUM

Barboros Bulvari Akdogan Sok. 37/3
80690 Besiktas, Istanbul

Turkey

Ph: 90-212-2581829

Fax: 90-212-2583567



United Arab Emirates

MITECH TRADING
P.O. Box 4886
Dubai

Ph: 971-4-624043
Fax: 971-4-665818

AL YOUSUF Computers
Pan Yas Street

P.O. Box 25

Dubai UAE

Ph: 971 4 826667

Fax: 9714 826863



United Kingdom

SEAGATE SOFTWARE UK
The Broadwalk

54 The Broadway

Ealing

London W5 55N

Ph: 0181 566 2330

Fax: 0181 231 0600

Distributors:

CONTEMPORARY SOFTWARE Ltd.
The Mews, Kings Ride Court

Kings Ride, Ascot

Berkshire SL5 7JR

Ph: 01344-873434

Fax: 01344-872228

E-mail: cssales@contemporary.co.uk
Web: www.contemporary.co.uk

IDEAL HARDWARE
265 Burlington Road
New Malden

Surrey KT3 4NE

Ph: 44-181-286 5000
Fax: 44-181-286 5056
Web: www.ideal.co.uk



Venezuela

L & C COMPUTER SERVICES, C.A
Av. Este 6, Centro Profesional Villasmil
Piso 8, Oficina 815, Caracas 1030
Venezuela

Ph: 582-576-0831 /582 573 3120
Fax: 582 571 4241

E-mail: arturolaos@true.net



Quick Start

If you are an experienced Windows user who wants to get right into the program, follow these steps to set up a report for the first

time.

1 In Windows 3.1 and NT 3.51, start the program by double-clicking the Seagate Crystal Reports icon in the Program Manager.
In Windows 95 and NT 4.x, click Start and then select the program from the Seagate Crystal Reports program folder.

2 Click the New button on the standard toolbar. The Report Gallery appears.

3 Select one of the eight Experts to build a report with the help of an Expert, click the Another Report button to use a template
for building your report, or click the Custom button to build a custom report. If you click Custom, the Report Gallery expands,
and you can then select a Report Type and Data Type for your custom report.

4 If you choose Custom and select:

n Data File, the Choose Database File dialog box appears. Select the first database you want to activate for your report.
n SQL/ODBC, the Log On Server dialog box appears. Highlight the data source you want and then highlight the first table you
want to use from the Choose SQL Table dialog box when it appears.
n Dictionary, the File Open dialog box appears. Highlight the dictionary you want to use for your report.
The Design Tab appears with Report Header, Page Header, Details, Page Footer, and Report Footer areas. You create your
report by inserting and formatting items in each of these areas.
,.-’& If you want to use additional
. database tables for your report
and match them up on a record-
by-record basis, click the Link
Expert button on the
supplementary toolbar and then
select the table(s) and set up the
links in the Visual Linking Expert
when it appears.

5 Each of the default report areas contains a single section. If you want to add additional sections, click the Section Expert
button on the standard toolbar and add the sections you want using the Section Expert.

Once you have added sections to an area, you can move, merge, and delete them in the Section Expert.

6 If you want to toggle the grid on and off, choose the Options command on the File menu and make your changes in the File
Options dialog box when it appears.

7 If you are working with the grid off and you want to use snap-to guidelines for positioning objects, click the top or left ruler
wherever you want guidelines to appear.

n Move a field to a guideline until it snaps to the guideline.
n Move the guideline arrow to move the guideline (and any objects that are snapped to it).
n Drag the guideline arrow away from the ruler to remove the guideline.

8 If the Insert Fields dialog box is not visible, click the Insert Fields button on the standard toolbar. The Insert Fields dialog box
appears with the Database Tab active. This dialog box displays a list of all of the fields in the active database table(s). To
speed the entry of multiple fields, the box remains on screen until you click the Close button. You can move the dialog box to
a new location or resize it if you wish.

9 Select the field(s) you want to appear on the report. You can select and place them one at a time, or you can use the Shift-
click combination to select a number of contiguous fields or the Ctrl-click combination to select fields from the list at random.
Drag and drop is also active. Place the fields in the Details section where you want them to appear.

10 If you place multiple fields, they will appear next to each other in the order they appear in the Insert Fields dialog box. The

program marks the position of each field with a rectangular frame. The characters in the frame indicate whether the field is text
(xxx...), number (555...), currency ($555...), date (12/31/99), time (00:00:00), dateTime (12/31/99 00:00:00), or Boolean (T/F).

,.-’& You can see the actual field names

and field types by toggling the
Show Field Names check box on
in the File Options dialog box
(Layout Tab).

,-’§ The program automatically places

field titles in the Page Header
section unless you have toggled
the Insert Detail Field Titles check
box off in the File Options dialog
box (Layout Tab).

,-’& If you add additional Details
sections to your report, please
note that field titles will only be
placed in the Page Header section
for fields in the Details A (the
original) section of your report.
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Once you have objects in place, you may want to adjust the report sections somewhat. You do this using the shortcut menu
that appears when you right-click the shaded area to the left of the section ruler.

n If you want to expand the section to accommodate an additional line, choose the Insert Line command.
n If you want the program to automatically align the objects in the section horizontally, choose the Arrange Lines command.

n If you want to reduce the size of the section to eliminate unnecessary white space above and below objects, choose the Fit
Section command.

To create a report title, you must first enter the title in the Document Properties dialog box. Choose the Summary Info
command from the File menu. Enter a title in the Title text box of the Document Properties dialog box. Click OK. Choose the
Report Title command from the Insert|Special Fields menu. A rectangular placement frame appears when you move the
cursor over your report. Click once in the Report Header (RH) section to place the report title. The report title field will contain
the text that you typed in the Title text box of the Document Properties dialog box. To see how your results will print, click the
Print Preview button on the standard toolbar.

n If you want to speed processing time while building your report, you can preview your report using only a small subset of
the available data. To do this, choose the Preview Sample command from the File|Print menu.

n In either case, the program takes you to the Preview Tab. You can fine tune your report in the Preview Tab if you wish while
seeing the results as actual report data. You can also close the Preview Tab and continue working on your report in the
Design Tab.

If you want to:

n change the placement or width of a field,

n format a field, or

n insert a subtotal or grand total,

click the field to select it. Handles appear on the top, bottom, and both sides of each selected field.

n To change the placement of the field(s), drag the field placement frame to its new position using the mouse.

n To change the width of the field, drag the right or left handle using your mouse.

n To format font, alignment within field, number, currency, date display, border, color, indentation, or to summarize the field,
right-click the field. A shortcut menu appears listing various commands for formatting and summarizing the field.

{& Many of the font and formatting
options are available on the format
bar.

{& If you want the formatting to apply

only under certain conditions,
click the Conditional Formula
button next to the formatting
property in the Format Editor, and
create a formula that defines those
conditions.

If you want to create a formula to make data calculations or comparisons, click the Insert Fields button on the standard

toolbar. When the Insert Fields dialog box appears, click the Formula Tab to activate it.

n Click the New button. The Formula Name dialog box appears. Enter a name for your formula and click OK. The Formula
Editor appears.

n Enter the formula in the Formula Editor. Enter fields, operators, and functions by selecting them from their respective scroll
lists or type them in. You can check your formula syntax via the Check button. When finished editing, click the Accept
button to return to the Insert Fields dialog box. Click the Insert button to place the formula just like you would a database
field.

To insert a subreport (a report within a report), click the Insert Subreport button on the supplementary toolbar and choose an

existing report to import as a subreport or use the Create Report Expert to create a new subreport.

n If you want the records in your subreport to match up with the records in your primary report, click the Link Tab of the
Insert Subreport dialog box and specify the link in the Subreport Links dialog box when it appears.

To insert a cross-tab object in your report, click the Insert Cross-Tab button on the supplementary toolbar and set up the

cross-tab in the Cross-Tab dialog box when it appears.

To create a parameter field (a field that prompts you for a value whenever you retrieve data for your report), click the Insert

Fields button on the standard toolbar, then click the Parameter Tab in the Insert Fields dialog box when it appears. Click the

New button to set up a parameter field. Once created, you can insert the parameter field in your report like a database field

or select it from the Fields list in the Formula Editor.

n You can use parameter fields in your report (as title or label prompts), in selection formulas (as selection criteria prompts),
and in formulas (for a variety of purposes including specifying sort fields).

To add a graph or chart, click the Insert Chart button on the standard toolbar.

To insert a spreadsheet, picture, or other OLE object that you can edit from within Seagate Crystal Reports using the tools
from the object's native application, choose the Object command from the Insert menu.

To change the record sort order, click the Sort Order button on the standard toolbar. The Record Sort Order dialog box
appears. Select the field(s) you want to use for sorting the report data and the sort direction.

If you want to limit your report to specific records (for example, the records of California customers that have year-to-date



sales greater than $10,000), click the first field on which you want your selection to be based and click the Select Records
button on the standard toolbar. When the Select Expert appears, set up your record selection criteria.

22 To print your report, click the Print button on the standard toolbar.
That's it! It is that easy to build a report.



What's New in 6.0 Index

Seagate Crystal Reports 6.0 adds a wide range of new features that build on the capabilities of previous versions. Integrating
new web reporting technology and advanced developer features with proven functionality ensures that Seagate Crystal Reports
6.0 can address all of your reporting needs.
d}_n] Click the topic of interest from the following list for further information:
Web Reporting Technology
mart Navigation™ On the Web
Crystal Web Report Server
Smart Viewers
Web Application Deployment
Arbor Essbase support extends reporting capabilities to OLAP data source
Improved RTF Exporting
Crystal Java Smart Viewer Issues and Restrictions



Web Reporting Technology

Whether you are hosting your reports on an intranet or extranet, or integrating reports into a web-deployed application, Seagate
Crystal Reports 6.0 contains new web reporting technology that provides you with advanced dynamic Web reporting capabilities
and lets you transfer existing reporting skills to your Web projects.

Reports created previously with any version of Seagate Crystal Reports can continue to be used—just host them on your ISAPI
or NSAPI-compliant Web server, install and configure the Crystal Web Report Server (included in the box with Seagate Crystal
Reports 6.0), and you're done.

] what's New in 6.0 Index



Smart Navigation On the Web

Automatically generated group trees provide an index to reports so users can quickly jump, with a single mouse click, to the
section of the report they need to analyze. They can drill down for more detail on graphs, group totals, and embedded hyperlinks.
A convenient search tool is also included.

3 what's New in 6.0 Index



Crystal Web Report Server

The thin-wire architecture of the Crystal Web Report Server ensures superior response times and reduces web traffic: users can
pull reports from the Crystal Web Report Server to their browser a page at a time as desired. An ISAPI/NSAPI-compliant
component, the Crystal Web Report Server is compatible with popular NT web servers including Microsoft Internet Information
Server and Netscape Enterprise Server.

= what's New in 6.0 Index



Smart Viewers

Seagate Crystal Reports 6.0 has Smart Viewers—thin-client add-ins that help you deliver platform-independent reporting
functionality without having to set up the application on client desktops. With Smart Viewer for ActiveX and Smart Viewer for
Java, you can view reports in native Crystal Reports format inside web browsers supporting ActiveX or Java. In addition, Smart
Viewers for HTML Frames or plain HTML gives users the ability to view any Crystal Report on any web browser.

= what's New in 6.0 Index



Web Application Deployment

If you're looking to create Web-deployed database applications, Seagate Crystal Reports gives you the same flexible reporting
power that you enjoy on the desktop. Seagate Crystal Reports 6.0 includes the Crystal Active Server Component, which lets you
integrate the Crystal Report Engine directly into Active Server Pages (ASPs). A Design-Time Control for Visual InterDev is also
included to make integration of reports into ASPs as simple as pointing and clicking.

= what's New in 6.0 Index



Arbor Essbase support extends reporting capabilities to OLAP data sources

Seagate Crystal Reports has always been known for its ability to report on a wide range of PC and SQL data sources. It now
reports on Arbor Essbase OLAP data as well. Whether your databases are relational or multi-dimensional, you can use Seagate
Crystal Reports to produce professional reports quickly and easily.

[ what's New in 5.0 Index



Improved RTF Exporting

&&& Seagate Crystal Reports 6.0 adds improved RTF (Rich Text File) formatting when you want to export reports in this format.
Now, saved reports exported using RTF format look more like reports exported as Crystal Reports (RPT) format.

= what's New in 6.0 Index



Advanced Developer Features Index

Seagate Crystal Reports 6.0 adds a wide range of new features that build on the capabilities of previous versions. Integrating
new web reporting technology and advanced developer features with proven functionality ensures that Seagate Crystal Reports
6.0 can address all of your reporting needs.

d}—"] Click the topic of interest from the following list for further information:
Smart Runtime Preview Window

Drill Down in Runtime Preview Window
tomizable Runtime Preview Window
Event an ll-back rt
r-Defined Function DFs) in Visual Basi
Automation Server
Improv rt for Apex True DBGrid 5.
Reporting from Application Data
Incr Dat rt
Year 2 FL
New Report Engin Il



Smart Runtime Preview Window
Seagate Crystal Reports 6.0 now has a smart Preview Window that provides unprecedented interactivity.

= Advanced Developer Features Index



Drill Down in Runtime Preview Window

Seagate Crystal Reports 6.0 offers new ways to drill into your data. In addition to drill down in the runtime Preview Window,
Smart Navigation helps you navigate through reports using group trees that act as indexes.

= Advanced Developer Features Index



Customizable Runtime Preview Window

Other new features within the runtime Preview Window include a printer setup button, variable zoom control, a refresh button,
and search capabilities. Enable any or all of the new features, or continue using the existing Preview Window - the choice is

yours.

=] Advanced Developer Features Index



Event and Call-back Support

New event support makes it possible to interact with your application through callbacks from the Crystal Report Engine. When a
user clicks on an element in the Preview Window, the application can present additional report details, launch another report,
execute application code, or do whatever you choose.

=] Advanced Developer Features Index



User-Defined Functions (UDFs) in Visual Basic

Creating formulas to add to the User-defined Formula Library (UFL) is simplified; now user-defined functions (UDFs) can be
written in any language that supports the Component Object Model (COM), including Visual Basic, C/C++, and Delphi.

= Advanced Developer Features Index



Automation Server

Seagate Crystal Reports 6.0 contains an Automation Server that provides object-oriented access to the entire Crystal Report
Engine via over 500 properties, methods, and events. If you're creating a project with Visual Basic, Visual C++, Visual InterDeyv,
or Office 97, this extensive support gives you the tools to tightly integrate and customize reports within your application.

The Automation Server also contains an Active Server Component which is used in conjunction with Microsoft IS and Visual
InterDev to drive the CRPE from Active Server Pages (ASPs).

=] Advanced Developer Features Index



Improved Support for Apex True DBGrid 5.0

When you generate a report from Apex True DBGrid 5.0, grid formatting information is retained, including font types, styles,
colors, sizes, and field widths. You don't need to make any changes to your application. Just install the latest versions of the
Crystal ActiveX Control and the Apex True DBGrid ActiveX Control. Formatting is retained when generating the report at runtime.

=] Advanced Developer Features Index



Reporting from Application Data

Connect to data sources on the fly. The new Active Data Driver in Seagate Crystal Reports 6.0 lets you create a report template
that you can use within your VB application. Then, at runtime, use ADO, RDO, or DAO to bind your report to any runtime data
source, including grid data. Or use the Crystal Data Object (CDO) to bind to application memory to report off memory blocks.

=] Advanced Developer Features Index



Increased Database Support

In addition to the 30 databases already supported (including most PC and SQL databases), Seagate Crystal Reports 6.0 has
new native database drivers for Informix, Arbor Essbase, Oracle 8, and the entire IBM DB2 family (DB2, DB2/2, DB2/400 and
DB2/6000).

=] Advanced Developer Features Index



Year 2000 UFL

AYear 2000 UFL is also included to convert 19xx dates into 20xx dates, based on user controlled sliding date.

= Advanced Developer Features Index



New Report Engine Calls
Seagate Crystal Reports 6.0 contains the following new Report Engine Calls for page-on-demand and formatting functions:
n PEGetGroupOptions

n PESetGroupOptions

n PEGetAreaFormatFormula

n PEGetWindowOptions

n PESetWindowOptions

n PEGetReportSummarylinfo

n PESetReportSummaryinfo

n PEEnableEvent

n PEGetEnableEventinfo

n PESetEventCallback

n PEGetTrackCursorinfo

n PESetTrackCursorinfo

= Advanced Developer Features Index



What's New in 5.0 Index
This is Seagate Crystal Reports as you have never seen it before. The program has been redesigned to improve performance
and offer an incredible list of new capabilities.
d}—"] Click one of the new features from the following list for further information:
Sensational new interface gives you power and control
Multiple section reports offer new reporting alternatives
Subreports expand report usefulness
Query Designer adds ad-hoc querying capabilities
Conditional formatting adds new intelligence to reporting
Parameter fields mean multi-purpose reports
Text objects give you text with intelligence
Preprinted-form reports easier than ever
Enhanced cross-tab capabilities help identify trends
More powerful formulas extend your capabilities
In-place editing makes it easy to edit OLE objects
Dragging objects between reports cuts creation time
HTML exporting simplifies Web activities

Running Totals made easy
IntelliMouse
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Sensational new interface gives you power and control
The report design environment offers greater flexibility than ever before.

n

The Design and Preview Tabs are broken into areas and each area can contain multiple sections, each with different data
and/or properties.

The Preview Tab now provides Smart Navigation technology in the new Group Tree view. Using the Group Tree, you can
quickly drill down on group data to review the details of each group.

The Preview Tab now lets you expand and collapse report sections so you can review data with different levels of detail.
The new Section Expert enables you to insert, delete, move, merge, and format sections from one place.
Vertical and horizontal guidelines make it easy to place and align objects with precision.

Multiple levels of undo and redo make it easy and safe to experiment, and they provide a fail-safe mechanism against
inadvertent errors.

The standard and supplementary toolbars and format bar can be moved, resized, and enlarged, enabling you to customize
your environment for maximum efficiency.

These are just a few of the new features in the design environment.
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Multiple section reports offer new reporting alternatives
Now you can include multiple sections in any area of your report and you can format each section independently of the others.
Using this capability you can:

n create custom form letters that deliver different messages to different readers,

n format numbers and dates differently depending on the audience,

n create unusual printing effects,

n force objects to print in the order you specify, and more.
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Subreports expand report usefulness

Seagate Crystal Reports enables you to create subreports and place them in your report. You can create freestanding reports
based on tables that are not related to those in the primary report, or you can bind the subreports to primary report data.

With subreports, you can create one report that provides all the information you need instead of having to create multiple reports.
You will find it easier to create reports and analyze report data with the new subreport feature.

Subreports can be inserted into most sections of the main report and the main report can contain numerous subreports.

Existing report files (.RPT) can be used as subreports. Subreports can have any report format; they can be cross-tabs or contain
graphs. Thus, you can present columnar data from one report right next to a graph from another report.

Subreports let you present different types and views of data all on one report for convenient viewing of information and efficient
analysis.
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Query Designer adds ad-hoc querying capabilities

Seagate Crystal Reports now includes a powerful Query Designer that allows processing of all aggregate functions on the
database server. A complete SQL Editor is included to fine tune your queries. And, as you would expect, you can create reports
from query result sets. Ad-hoc queries, reports, or both? Seagate Crystal Reports has it all.
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Conditional formatting adds new intelligence to reporting
Seagate Crystal Reports has always been known for its flexibility in formatting report data. This version takes a giant step
beyond earlier versions by allowing you to format data conditionally based on whatever criteria you want to use.
n Do you want sales figures to print in red if more than 10% under quota, in green if more than 10% over quota, and in black in
all other cases?
n  When your data contains domestic and international data, do you want to print dates and currency values in the expected
format for every country?
n Do you want a section to print only if it contains a record from a Canadian company?
n Do you need to customize your report colors to meet corporate standards or design requirements?
You can do these and countless other things using conditional formatting.
Virtually all field, object, and section formatting (color, font, border, alignment, visibility, and more) can be controlled by creating
simple, straightforward formulas.
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Parameter fields mean multi-purpose reports

Now you can create parameter fields. Parameter fields prompt you for a value when the report is run for the first time or the data
is refreshed. With parameter fields, you can:

n change report titles or labels,

n modify record selection criteria,

n specify sort fields, and

n set threshold levels for flagging purposes,

all by responding to simple prompts when you run the report. Using parameter fields you can create a single report that satisfies
a number of needs. It makes your work easier and more efficient.
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Text objects give you text with intelligence
Text objects give you flexibility and control when you insert text in your report.

n

Text objects replace text fields. A text object can contain a character, word, paragraph, or even an entire document, making
them perfect for creating customized form letters.

Each text object contains its own mini word processor, making it easy to insert and edit text.
Text objects and elements within text objects can be independently formatted with fonts, colors, line breaks, tabs, and more.

Database fields can be inserted into a text object in-line with automatic trimming to fit properly within text. Text objects can also
contain formula fields.

Text objects can be inserted and edited in-place on the report, making report design easier. Now you can readily see how a
text object looks on the page in relation to other objects.

Presentation quality is improved with total control and flexibility over text object formatting.

= what's New in 5.0 Index



Preprinted-form reports easier than ever

The ability to design reports that print on forms is greatly enhanced now that you can place objects anywhere in the new
freeform, drawing program-type environment. New rulers and guidelines facilitate the precise placement of objects on the form,
and the built-in tab and ruler capabilities in text objects gives you more flexibility and control. There's even a new Forms Expert
that speeds the design process. For fast, efficient reporting on preprinted forms, you can not beat Seagate Crystal Reports.
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Enhanced cross-tab capabilities help identify trends
Cross-tabs are now objects that you can insert into your report.

n

n

n

You can insert as many cross-tabs as you need, and you can even insert cross-tabs in subreports.

You can use formulas that are defined elsewhere on the report in cross-tabs.

You can include multiple summary fields or calculations in your cross-tabs. For example, for a single item you can
summarize both quantity and price information.

You can independently format rows and columns with background colors, borders, and fonts for better looking and easier-to-
understand cross-tabs.

You can print cross-tabs that extend beyond the width of a page. You can also create cross-tabs that are longer than a single
page and the program will automatically repeat the column headings at the top of each page.

You can design and edit cross-tabs easily with the ability to call up the Cross-Tab Expert from both the Design and Preview
Tabs.

Using these capabilities, you can create sophisticated cross-tabs like this with ease:
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More powerful formulas extend your capabilities

Seagate Crystal Reports includes new functionality that lets you create even more powerful formulas than ever before. With
Date, Time, and DateTime data types, you can now create date formulas, time formulas, and date/time formulas. With the ability
to place arrays in variables, all new running total functions, as well as specialized financial functions, your complex reporting

needs are easier than ever before.
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In-place editing makes it easy to edit OLE objects
Seagate Crystal Reports draws upon OLE technology to add solid new functionality to your reporting environment.
n All pictures are converted to static OLE objects. Double-click an object and the program displays the tools to edit that object,
all while staying in Seagate Crystal Reports.
n  While working in the Design Tab, you can convert OLE objects to a format that is supported by your editing tools. For

example, if you have a .TIF picture and no .TIF editor, you can convert the picture to a Paintbrush format that can be edited
in the paint program that ships with Windows.
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Dragging objects between reports cuts creation time

Now you can open multiple reports and drag many kinds of objects between them. Now there is no need to "reinvent the wheel".
If you have an object in one report and you need to use it in a different report, just drag it where it is needed.

You can also drag objects into Seagate Crystal Reports, from any application that is an OLE server application. Microsoft Word
and Excel are examples of this kind of application. Just highlight the object (such as text or worksheet cells) and drag it into the
report. The object becomes part of your report. Double-click it and you can edit it in place using the application you created it

with.
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HTML exporting simplifies Web activities
With Seagate Crystal Reports, you can now export your reports directly to HTML format. With this capability, you can publish
your reports on the World Wide Web and on organizational intranets. Combining this capability with other Seagate Crystal
Reports features, you can add dynamic reporting to your web applications. Some benefits of exporting to HTML include:

n HTML report can be viewed by any web browser.

n Specific Microsoft, Netscape, and Oracle web extensions are available when exporting to HTML.

n Reports are automatically converted to HTML, saving you time and tedious effort when preparing database information for

the web.

As the Internet and intranets become more and more important to many businesses, Seagate Crystal Reports is providing the
tools you need to take advantage of the new opportunities.
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Running totals made easy

Seagate Crystal Reports has always been the industry leader when it comes to sorting, grouping, and totalling data. With the
inclusion of specialized running total functions, it extends its lead even further. Now you can create running totals in a list,
running totals group-by-group, and other advanced totalling activities using fewer and less-complex formulas than ever before.
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Crystal Java Smart Viewer Issues and Restrictions

The Crystal Java Smart Viewer now contains Java 1.1 functionality. The benefit of implementing Java 1.1 is that users can now
print reports with the Java Viewer from web browsers that support Java 1.1. The viewer has been designed to execute Java 1.0
code when it is running in browsers that only support Java 1.0. There are a number of design issues and restrictions that the
user should be aware of when using the new applet in their web pages.

@ Click the area of interest on the list below for further information:
Browser Versions
Packaging
Security
Applet Tag Settings

Netscape 2.02
Netscape 3.x
Netscape 4.x
Internet Explorer 3.x
Internet Explorer 4.x

Limitations
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Browser Versions

This version of the report viewer will work with browsers having either Java 1.0.x or Java 1.1.x, but printing is only possible from
the very latest browsers from Netscape and Microsoft. By default, the Print button is omitted from the viewer. If the

'HasPrintButton' parameter in the applet tag is set to true and if the browser's Java implementation supports printing, the Print
button is included.

Navigator 4.03 or 4.04 are capable of printing from a Java applet only if a JDK 1.1.4 patch from Netscape is first installed..

Internet Explorer 4.0 includes printing support but a bug in its Java implementation prevents printing to many printer drivers. The
recently-released IE 4.01 fixes many of these problems.
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Packaging

When an applet tag does not contain a value for the archive parameter, web browsers that do support this parameter will
download each class file one at a time. Thus, causing an individual http request for each file. This can cause a serious
performance constraint when using applets that contain many class files.

Netscape and Microsoft provide different solutions to this performance problem. Navigator 3.x and 4.x allow the individual applet
files to be packaged in a single uncompressed ZIP file, greatly reducing the viewer's startup time. Microsoft went further by
allowing the use of a compressed CAB (cabinet) file with IE 3.x and 4.x.

For Java 1.1 applets, though, the officially sanctioned packaging is the compressed JAR (Java archive) file. JAR files are
supported by Navigator 4.x and to a limited degree (see below), by IE 4.x.

To support the various types of browsers , Seagate Crystal Reports installs the Java Smart Viewer on the web server in several
forms: as a set of individual class and image files, as an uncompressed ZIP file, as a compressed CAB file, and as a
compressed JAR file.
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Security

By default, Java applets are not allowed to print. Printing is considered a slightly dangerous operation (an applet might
maliciously generate a million pages of output) and so is restricted to trusted applets only. In Java 1.0, no applet is trusted.

In Java 1.1, only an applet that has been digitally signed by the vendor can be trusted. When the signed applet is downloaded by
the browser, the user is presented with information about the vendor from the digital signature and asked to grant or deny the
particular capabilities requested by the applet.

For Navigator 4.x, an applet is signed by putting additional information in the JAR file. IE 4.x will read a signed JAR file, but it
ignores the signature and will not consider such an applet to be trusted. Instead, IE 4.x insists that a trusted applet comes from a
signed CAB file.
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Applet Tag Settings

If various types of browsers are being used, the developer can use a scripting language such as Java Script to customize the
Applet tag referencing the Crystal Java Smart Viewer. The following is a sample HTML page that exemplifies this procedure.

/\/} Due to the Crystal Java Smart
Viewer being contained within a
Java package
(com.seagatesoftware.img.Report
Viewer), the code parameter of the
applet tag must provide the
absolute name of the

ReportViewer applet:
com.seagatesoftware.img.ReportVi
ewer.ReportViewer
<html>
<head>
<title>Seagate Crystal Smart Viewer for Java</title>
</head>
<body>
<SCRIPT LANGUAGE="JavaScript"><!--
var ns3 = false;
var nsé4 = false;
//-=></SCRIPT>
<COMMENT>

<SCRIPT LANGUAGE="JavaScriptl.l"><!--
var 1info = navigator.userAgent;

var ns3 = (navigator.appName.indexOf ("Netscape") >= 0 &&
_info.indexOf ("Winlé6") < 0 && _info.indexOf ("Mozilla/3") >= 0);
var ns4 = (navigator.appName.indexOf ("Netscape") >= 0 &&

_info.indexOf ("Winlé6") < 0 && _info.indexOf ("Mozilla/4") >= 0 );
//-=></SCRIPT>
</COMMENT>
<SCRIPT LANGUAGE="JavaScript"><!—
//1f Netscape 3.x browser, set archive to .zip file.
if (_ns3==true)
document.writeln( '<applet code =
com.seagatesoftware.img.ReportViewer.ReportViewer
codebase="/viewer/JavaViewer" id=ReportViewer width=100% height=95%
archive="/viewer/JavaViewer/ReportViewer.zip">"' );
// If Netscape 4.x browser, set archive to .Jjar file.
else if ( ns4 == true)
document.writeln( '<applet code =
com.seagatesoftware.img.ReportViewer.ReportViewer
codebase="/viewer/JavaViewer" id=ReportViewer width=100% height=95%
archive="/viewer/JavaViewer/ReportViewer.jar">"' );
//Unknown browser type, download all .class files.
else
document.writeln( '<applet code =
com.seagatesoftware.img.ReportViewer.ReportViewer
codebase="/viewer/JavaViewer" id=ReportViewer width=100% height=95% >');

//=-=></SCRIPT>

<param name=ReportName value="/reports/testpc.rpt">
<param name=HasGroupTree value=true>

<param name=ShowGroupTree value=true>

<param name=HasRefreshButton value=true>

<param name=HasPrintButton value=true>

<!—This parameter is only analyzed by ie 3.x/4.x browsers
<param name=cabbase
value="/viewer/JavaViewer/ReportViewer.cab">

</applet>
</body>



</html>
The following examples are sample applet tags for various types of browsers.
n N 2.02
n Netscape 3.x

n Netscape 4.x
n Internet Explorer 3.x

n Internet Explorer 4.x



Netscape 2.02

<applet code=com.seagatesoftware.img.ReportViewer.ReportViewer

codebase="/viewer/JavaViewer"

</applet>

<param
<param
<param
<param

id=ReportViewer width=100% height=95%>

name=ReportName value="/reports/testpc.rpt">
name=HasGroupTree value=true>
name=ShowGroupTree value=true>
name=HasRefreshButton value=true>

3

Netscape 2.0 does not support .zip
or .jar files, so browser must
download each .class file
seperately
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Netscape 3.x

<applet code=com.seagatesoftware.img.ReportViewer.ReportViewer
codebase="/viewer/JavaViewer" id=ReportViewer width=100% height=95%
archive="/viewer/JavaViewer/ReportViewer.zip">

<param name=ReportName value="/reports/testpc.rpt">

<param name=HasGroupTree value=true>

<param name=ShowGroupTree value=true>
<param name=HasRefreshButton value=true>
</applet>
é} Netscape 3.x supports .zip files.
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Netscape 4.x
<applet code=com.seagatesoftware.img.ReportViewer.ReportViewer
codebase="/viewer/JavaViewer" id=ReportViewer width=100% height=95%
archive="/viewer/JavaViewer/ReportViewer.zip">

<param name=ReportName value="/reports/testpc.rpt">
<param name=HasGroupTree value=true>
<param name=ShowGroupTree value=true>
<param name=HasRefreshButton value=true>
<param name=HasPrintButton value=true>
</applet>

{’} Supports .zip and .jar files. User
must set archive parameter to .jar

file if he wants to be able to print
from applet(.jar file has
authentication signature).
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Internet Explorer 3.x

<applet code=com.seagatesoftware.img.ReportViewer.ReportViewer
codebase="/viewer/JavaViewer" id=ReportViewer width=100% height=95%>

<param name=ReportName value="/reports/testpc.rpt">
<param name=HasGroupTree value=true>
<param name=ShowGroupTree value=true>
<param name=HasRefreshButton value=true>
<param name=cabbase value="/viewer/JavaViewer/ReportViewer.cab">
</applet>
{’} Supports .cab files. The user will
be prompted to accept the
certificate, but no printing

functionality due to browser only
supporting Java 1.0.
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Internet Explorer 4.x

<applet code=com.seagatesoftware.img.ReportViewer.ReportViewer
codebase="/viewer/JavaViewer" id=ReportViewer width=100% height=95% >

<param name=ReportName value="/reports/testpc.rpt">

<param name=HasGroupTree value=true>

<param name=ShowGroupTree value=true>

<param name=HasRefreshButton value=true>

<param name=HasPrintButton value=true>

<param name=cabbase value="/viewer/JavaViewer/ReportViewer.cab">
</applet>

{} Support .cab and .jar files. User
must set cabbase parameter if
they would like to be able to print
from applet(ie 4.x does not
authorize certificate from jar file.
Refer to security section)
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Limitations

n

It is not possible for Java code to set the page orientation or paper size. Even though the report viewer knows whether the
orientation is portrait or landscape and what size the page is, it cannot currently change those settings in the print dialog that
the user sees.

If the user changes the orientation and the paper size in the print dialog, these changes are ignored. As a result, only reports
that match the printer's default orientation and paper size will be printed properly.

Java automatically add top and left margins to the printed pages but Java code has no way to determine what those margins
are. If a report's margins don't match these automatic margins, the page contents will be shifted on the paper.

Java only allows all pages in a report to be printed. The print dialog does not allow the user to specify a range of pages.

The JVM in IE 4.0 has a bug that prevents printing to many printer drivers. With these printer drivers, there is a null pointer
exception in Microsoft code when the report viewer tries to print the first page. The exception is caught by the viewer, which
displays the message "Unable to print report" to the user. This bug was fixed in IE 4.01.

With some printer drivers, the report viewer cannot draw white text on a coloured background. The white characters are
drawn with a white background that overwrites the coloured background and renders the text invisible. Interestingly, Seagate
Crystal Reports can successfully print the same reports with these printer drivers. Using a different printer driver to print to
the same printer can solve the problem.

There appears to be a minor bug in Navigator 4.x where it is unable to locate image files that are in the same JAR file as the
class files. Fortunately, there is a simple workaround. If the individual image files are also installed on the server and the
CODEBASE attribute of the APPLET tag points to their location, Navigator will use those images. If, as stated above, the
applet is installed on the server both as individual files and as ZIP/CAB/JAR files, this problem is solved transparently
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